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ShowDirector Product Do

To download the ShowDirector installer, click the Download botton bel
browser, you have have to authorize the the download to begin or sele

d the download will begin. Depending on your
o location where the download will go. By

default, most browsers will place the installer in your users Downloa or, If you already have Show Director or
Visual Show Director version 8.2.0 or greater, you only need t¢' download and install the Patch.
After your browser has finished downloading the instailer, go to that folder and run InstallShowDirector.exe (or

PatchShowDirector.exe).

NOTE: It is likely that your browser will complain about the dq
an executable file ending with .exe, That is why you will neeg
it was downloaded to and run it from there.

After you have successfully installed ShowDirector, run it. Ahg'first thing you will be asked to do is Activate. You will need
your Product Serial Number that you received by email finityVisions.

Select your product from the dropdown, enter your Sefial nfimber and press Activate,
More help on how to activate your product can be ,

Click here to read the Terms of Use agreement. By gifiing the Download button below, you have agreed with these
terms,

Download the complete ShowDirector Instalier

If you already have Show Director or Visual Show Director version 8.2.0 or greater, you only need to
download and install the Patch.

pad and not allow you to run the Installer directly as it Is
er-ride the download and go directly to the folder that

| Download the latest ShowDirector Patch |

IMPORTANT: ShowDirector requires Microsoft Access 2007 run-time package in order to take advantage of
the load and save of Excel XLS files. If you desire this feature, you must either have Microsoft Office 2007

or greater or download the run-time package from the Microsoft website at Access2007 Runtime Download
Page.

If you do not wish to install this package, you can still load and save data for Excel using the CSV format available within
ShowDirector.

Lk to- ShowDiwector 8 0 Releapa Notes
Link to. infintyVssons Scliware FAQ

copyright 1995-2015 InfinityVisions Inc - All rights reserved - Privacy Policy
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o ASEIBHDTDA LA M—/LET21E 8.2.9 URTD/NR— 3 OB, H&#ID Y > 7 [Download the Complete
ShowDirector installer] Z#{R L T, 7/l A > 2 b—AZETLTL &, 9 T2 [Show Director] £7-1%
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r — —
l':;, Show Director Activation Form @M

— Ak e = i,
WARNING
If you have a security key, please plug it in how or type in the Serial Number and Unlock Codes l
provided to you.

This software needs to be activated in order to work properly.

If you da not yet have a Serial Number or you need to by more time, I
please visit:  http: /Awww.infinityvisions. com

Installation |d: |1 991363160 Copy |

— Show Director

Product: |< Please Select Your Product Type> _:J @

Serial Number: I Activate |
Unlock Code: ||

Cancel 0K

o Show Director] (FEHIEOHLE, 9.  [Visual Show Director| 1%, T X TCORTALa v R—% v NG i
RO T, 20T E HiZ, [Online] 7-L® [Buytimeasyougo) /N— a2 & LTAFTE
F9, WEEARC, RERIF (A, PR, E72034F) ISV TEA L2834 1%,  [Online Product] & 720
e N
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| E:L Show Director Acthiatio_: F<_>_rm '. . - @&lﬂ
WARNING
If you have a security key, please plug it in now or type in the Serial Number and Unlock Codes l
provided to you.
This software needs to be activated in order to work properly.

If you do not yet have a Serial Number or you need to by more time,
please visit:  http://www.infinityvisions.com

Installation Id: I1 981363160 Copy |

— Show Director

Product: I<Please Select Your Product Type> _:_]
: <Please Select Your Product Type>
Serial Number: Visual Show Director

Visual Show Director Online
Show Director
Show Director Online

Unlock Code:

Cancel 0K

o HINAZREAT DL, EAEZD [Serial Number| Z#ETeE A —ANELNET, Z DfEA [Serial Number] A7)
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—VICBEILET, BRERFCII, vy 7RI FERERET D LTERRA—NAEZAALTIEZIN

o
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Show Director Activation Form W R

WARNING

[

If you have a security key, please plug it in now or type in the Serial Number and Unlock Codes
provided to you.

This software needs to be activated in order to work properly.

If you do not yet have a Serial Number or you need to by more time,
please visit:  http: /Awww infinityvisions.com

Installation |d: |1 981363160 Copy |

- Show Director

Product: I"Jisual Show Director _v_] [
7FB4B1C0-F734-4F21-BCDS-CCBS0C4BB214, Activate

Serial Number:

Unlock Code: |

Cancel oK

o  [Registration Form) DOAJR85%E T L TRED KL 5 &, [Registration Form) 23RS 4L, FER A —/L A
EESNET, Z0a— FEERICEERDOT, RERFFTITRIFL TIIZEW,

L INFINITY VISIONS SOFTWARE ACTIVATION AND REGISTRATION
Thank you for registering your software. Please Print out this page for future reference

PRODUCT: Vigual Show Drector (8.0.216)
SERIAL AUMSER:7FOA31COETM4F2 1. BCOSCCBS0CA6821A
INSTALLATION [D:1381353160

UNLOCKING CODEj23EE08H002GE11DE43BG02BG26CB43EAS03

Registrant data:

NAME:Grag Hgh

COMPAN'Y: Sanjun

ADCRESS: 100 SE 16th St Batevus, WA
EMAIL:greg@savum.com

You have 1 activations ket on this serl number,

Copyrighs 19932043 Infirey iwons Inc- AB righss reserved - Privacy Ficy

. AR U E T IXZAT LIoMERR A — /L)y 5  [Unlocking Code] % =2 &°— L. [Unlock Code] AJI7N > 7 AIZHL D £
JET, [OK|ARZ L E2MLT, Tur 7600y 7 2R LT 77T 4 7ICLET,
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Show Director Activation F ot =t
El ow Director A “i lO:: c‘>_rm .
WARNING
| If you have a security key, please plug it in now or type in the Serial Number and Unlock Codes l
provided to you.
This software needs to be activated in order to work properly.

If you do not yet have a Serial Number or you need to by mare time,
please visit:  http: /Awww.infinityvisions. com

| Installation Id: |1 931363160 Copy |

— Shaow Director

Product: isual Show Director v
Cerial Number: |7F54B1 CO-F734-4F21-BCDB-CCB50C46B21A Activate I

Unlock Code: | 23EEDBHCO2GE T 1DE438G02BG26CB43EAG03 c

Cancel 0K |
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o [SHOWDIRECTOR.ZIP] %#f#®R L T [DriveD:] [ZANET,
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[Visual Show Director]| D#ZE)

F A7 s 7® [ShowDirector] 7 A 22X 7)V7 ) v 7 LET,
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Visual Show Director Version8.2.18

¢

Visual Show Director
Multimedia Edition

Toolbar Layout ZREJ 5
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o VLTI, Yav=s bOEKR, BE, By N v S ICHBERIEIERERE~DOa— Ny FREE
NTWET, ZIHIT_RTOTa— by M, A A 3—¢ EEAN—1ZH D AA 7 (File, Format, Visual,
Cues, Effects, Firing, Configure, Manual, Reports, Window, Help) ZHAGAF I TWE T,

e [TOOL BAR CONFIGURATION | Dff1F:
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[Practice Project] % B <
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e [Project] ¥ 1 L7 kU 4@ [MONTREAL2017] /@ [MONTREALI2017.pyr.] % SR LT =2 2B £,

£ Visual Showr Directar u@@ﬂ— O X

. Mew Project

IEI Open Praoject..
= Sawve Project

é Sawve Project As..,

@ Close Project

l Project Librang..

Script File

Script Filter File
Script Sort File
Effect File

Effect Filter File
Effect Sort File

Visusl Script File
Visual Position File
Visual Library File
m Wave File

. Print

Eyxit
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[Demonstration Project] #ffH LT, ¥ a—2nED X 5 ITH
K. A7 VT MEER2D0, £7- [ User Interface | DHERK.
HAL <A XD TGk EITHENUB LA T EE W,

ST, Wi, FLnWFevzs FOERFEEZEZEVET,

[New Project] %{ERRT %

[Project] DERICEIT 25EMIEHIL [User Guide] Z#ZM L T Z S0,
Demo Project | ZBIWTWAEA, RELTHALHUTLEE Y, EHOY—A =0 [File]| # 7% 27V v 27 L,
[New Project]| 7 UV w27 LET, ZivE A A 7 4/LZND D:\SHOWDIRECTOR\PROJECTS\ | (ZfrfF L £,
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"MyProject] [D:\SHOWDIRECTOR\PROJECTS\MyProject] & \> 5 4 {ic> 7 s L 5 4 {Epk L £
FLEOLH T THLW T B Y =27 FEERL T EEN,
BIZAIXZ ZTlX, vy =2 4% MyProject] &4AfTHTET, )

€ New Project File

-

% w Data (D) > SHOWDRECTOR » PROECTS » MyProject v & earch Mybroject o

Organize = New folder
B Desitop
+ Documert
& Downloads
d Musc
= Picturas
B videos
- U5 Install (C)

' e Dota (D)
¥ Nebwork

4 Homegroup

File name: | MyFirstShow Project Fies (*.pyr)

Cancel

e [Open]%7 Vw7 LTHLWTr Y27 MEEKRLET,
e RIZ. [File] > [ScriptFile] > [New] Z#ER L C, v =7 NHOH LWAZ U7 N E/El L £,
V7 M= T T, T7ANVIREICES T, 7=y NAIHERESNTZ 7 A VX7 T U RN EERE I

F9, BIRL7E 7 4V HICESE [Script) 74 WVFZER L, 728 20F [Testl) EWIHIFHLWAZ U7 ~EAERk
LET,

53 Create Script File X

T

Organize «
¢@ OneDrive

3 This PC
[ Desktop
@ Docurnents
* Downloads
J‘! husic
| Pictures
B videos
e 05 Install (C3
- Data (D)

E N

<« Data (D) » SHOWDIRECTOR » PROJECTS * MyProject

Mew folder

Marme

v @ Search MyProject

e

Date modified

Moiterns match your search,

File name: |

~ | Script Files (*.5c)

P
o @

Type

Cancel
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e [Open]zZ7 Vw7 LTHLWAZ YT EERLET, ZNEND [Cue) OIFHRZAZ VT MET 57200
Fh B) ZELZEMOAT Ly Ry—FOEXE LTERENET, ZRHD 2T AF, 22— —DHHOR
BICHIET AN TEET, ZOTET Y27 P THEH, RO HIITHBESNTVET,

WOFINETIX, [Project] Z1EKT 27-DIZE /29 _TCToD [Files) # &£,

Import Audio .wav File: User Guide Chapter

WDAT v I T, =T 4774V FH) ZHEET,

. [Show Director] %16 £ » wave AL ET, 32 v b WaveFiles| 1316 £y MIE#HL T EE
VY, [File] A ==—>[WaveFile] C, 2> Ea—¥DA4—T 4477 A /V%&.wav EXTERLET, ZOHIT
. [D:\SHOWDIRECTOR\MUSIC:] 75 [SOUNDTRACKwav| 4 —F 447 7 A L EMHALET,
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| s Mutlclools  MUSIC adi=es %
“ Home Share View Py 0
1 & ) /4 :'_,Hr-'ngm' | :d.'lp-_n 2 }}j'«‘.'t" wi
ffi=2 - - . v :
* m= Copy path Exiyacoess v x R Select none
opy | Mo Cogpry Dutats Baname New Fropettns .
= {#] Pt ! we e - folder - £ Hirtory <= et jelection
Clipboses rgenge New Qper select
- + + ThisPC » Data (D) + SHOWDIRECTOR « MUSIC v & asrch M. 9
B Desktop ol Natra f >~ Title Ateibuting o
5| Documents ) SOUNDTRACK
& Downloads
D Music
= Pictures
B videos
e 05 Instat (C)
o Data (D}
@ Network
4 Homagroup
v < >
| itern | fem selected 30.8 ME g =

. [SOUNDTRACKwav] Z#ERL T, 7B x7 MIA R —

Wi File Processor FLEI,
-~ File Infa Ty b A RENELTHE, AT 4 AT T T ORMEL LY
File Size [bytes]: 34772860
Duration [sec): 480,571 762707493 EHHZENTEET, TITHE, 774/ MEOE ETHRIEIZH Y
Plat file exists: Ma .
— Optians
Charnel Selectar
(F Left " Right o FHEDOLOBAIL, [Channel Selector] > & [Left] 7>[Right]

ZBRLET, B, HO2TF ¥ RN 22—V v I R3dHY ., HOF

¥ %Wz [Timecode] NHAHHEAIE, 22—V v 7 F v riLa

Reduce file zize by factar af: |1 E9

™ Force rebuild of plat file.
— Progress IR FE 9,

o [Start] 27 U v Z L%,
o Z® lAudio)] 7 7 A NVOFHAREREIL8 45 TY, Fa—DE
ERDHZOIZT 4 RUICERINET,

Stop Cancel
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ANE "IV X -

o A —TAFTFANERY 4 RUD [ZoomIn] ¥ 7T, =T 4 A7 7 A NVE L VERHICRRTEET,
[Zoom Reset] # 7 C, JLIZREY £7°,
o fH/EIX, [F2] £721% [StreetLight] 74 2> %227 U v 7 LTL &V,

B Vil Show Director - (M mstShow)

worea (X

00 010z 090109
00:00:59:21 Zoemin | Zoom 0| Zoomflest | )

k= -

[Effects Manager | ZBi<: User Guide Chapter

[Effects Manager] 1%, Y7 b7 =7 OHFTH, OLARNORHENOMIELZFF> T ET, —fFl&E LT, ALY
FTICAZ VS NZ=T7 =27 b ) ZHATE 58EENH Y £9,  [Effects Manager] 1X— 72 VBT 5 LB
B ETN, ZO®RIE, [Cl-E] TRRT L2 THATEET,

o Tl&., [lEffectsLibrary] 7o ¥ =7 F&BEE L L 9, [File] A== — > [EffectFile] > [Open]
ZoflTix, [D:\SHOWDIRECTOR\PRODUCTS\'EFFECTS MANAGER'S] 7 4+ /VX\Z% %
[SUPERLIBRARY.efx] & WO BEfFDT — 2 R—Z &L £,
19


http://www.infinityvisions.net/doc_vsd/VISUAL%20SHOW%20DIRECTOR%208.html?WorkingwithEffects.html

8 Quick Start VisualShowDirector

HEE: A% [Projects| O7=DIZ, BFOT — 4 _X—R & 5| &fgE T2, 22—V —OEFEE I3 KL%
FHASWTME O [Effects Library | #8452 &6 TXEJ, MHA O [Effects Library] X, —E#L95&, £
BT, LT R =27 FERZ YT MET LN TE 3, BEFD Excel £ XU FY VT 7 L2 ANG
MED TEffects] 77— 2 X—=ZA&/ERRT 5121E. ZH 5D [Video Tutorial] ZZML T 7230,

e 73 /LXWN® [SUPERLIBRARY.efx] 7 7 A NZEIRLET (ho7av=7 b THEHATES LI, HrLno
Txl 877 A /Nefx BRI CHATICHRELET) o

SHECT JAGER a - 0
. 0
v X =]
Mowe (oo Dedete Menyey
e tow . ‘
This PC » Deta (D0} SHOWDRECTOR PROCUCTE EFFECTS MANAGERT
£ Dropbox
& OrDiive TVERLIERARY afx
LUTRATEC EFFECTS MANAGER o8
W This PC
B Desttop
Jotument
& Dowmloy
D Maic
w Pebure
B Vdeor
- U5 Install
- D23 D)

H o=

1] () L L0 |t S £ | et | Pt L e | e L G T CHne | amied | O e s | as L e | .-
s &

[Scripts| & [Effects Manager] ®D7-¥IZ [Sorts and Filters] % B <

20



8 Quick Start VisualShowDirector

'Sorts and Filters] (%, §<72->7= [Scripts) < [Effects Manager] O34 %M LT, MBRAHHIC ) ©4F—

FLTSHVET,

[File] A ==2—"T,

'D:\SHOWDIRECTOR\SORTS FILTERS] 7+ V¥ MNOLLTFO7 7 A VEBE 7,

([File] > [Script Filter File] > [open] > D:\SHOWDIRECTOR\SORTS FILTERS, > [Script Filter Manager])

b & [AHED FIET [Script Sort File], [Effect Filter Manager], [Effect Sort Manager] 7 7 A /L& B & £ 7,

= | SORTSFILTERS
Share

—
=

Pinto Quick Copy  Paste
access

Home Wi

4y Cut

Clipboard

—

T

A
-
&* Dropbox

f@ OneDrive

3 This PC
[ Desktap
|| Docurents
& Downloads
J’! Music
&=/ Pictures
m Wideos
i 0% Install {C:)
- Data (01

4 items

e Copy path
7] Paste shortout

X

Mowve  Copy Delete Rename

to to f

rganize

» This PC » Data (D) » SHOWDIRECTOR » SORTSFILTERS

Mame

| | SUPERLIBRARY efr

| | EFFECTSSORT.esr

| | SCRIPT SORT.sfr

| | MASTER SORTS SCRIPT.ssr

L':‘_]New itern ~
7 | Easy access v
e
older
e

Date modified

130720017 5:07 Ak
207207 422 P
210727 312 P
1207217 1251 PM

O X
7]
Open Select all
v -
Edit Select none
Properties
pv £ History DDIn\tert selection
Open Select
v O Search 0., 0
Type Size
EFF File 132 KB
ESR File S0KR
SFR File 282 KB
53R File 62 KB

[PrE=ETN

74 v RO

LW v R OB,

[Video Tutorial | #ZM L T &0,
TRTOY 4 RUBBAWVTNAS EEIZIE, thoT 4 RUREND Z EX3H Y £7, [Tile Horizontal] TV 1 >

(ZANFKR) &Rk O HIK & 72

RO ZIW~NEZTHD, Uy RUDERBICT VA Z S TTRRLEL T EIVY,

o UV RUDOIEIL, FU 4y RUHAD [©0] (WRH) OLZMHEHTLEIICERLTIEIN,

o HEIEZIIKERIZ O —NAN—=2HETIZF L~ AZ—=T 7V r—a v g0y RUBRFET 25813, &7
4 RTDOFVREFHALTCR T v 7 LAanTLEEn, Zhizk v [Tiling)
nET,

o MRAEZT LTWGAIE,

> R DOEERBRIC X
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[Tile Horizontal] (A == —/3— > [window] > [Tile Horizontal]) #7 UV v 27 LT, VU«
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o EEETRIC, ZOLAT UMY =) FapfFdToL, TORRALTmEAZEHY RTHLETHY THEA
o RIFT2ITIX [File] # 7% 27 Y v 7 L. [SaveProject] iR L EJ, ZIT, WOTHLIDLAT U F&EMD
ZERTEET,

>EBEDA VI T2 —AZRRTELLITV A FUZBEL XY,

S L[ L L)

FEpR———

“RLLLLIE]

[SHOW DIRECTOR| u =7 DR T 9, [VISUAL EFFECTS] ZfEREFIZAZ U b
PERT AEAITIE., Z2DEFE ISCRIPT| DERREAF— FTXE T,

XHZ 26T TVISUAL SHOW DIRECTOR] O A RT9, [VISUAL] OFIEICEHRAEL L D !
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Visual Simulation

[Visual Files]| User Guide
[Viewer] CT¥ a —%4F4A457-®I12iE. [Visual Show Director] 123 2D 7 7 A /LD v FBLETT,

Visual Files _|¥5 ¥P YL
¥5 visual Script File
¥P visual Position File
YL visual Library File

[Visual Script File (.chr)] :

o WHEDPAZIVZHFEFEUL, Ya—DIIalb—3 3 EIfTOHIC [Viewer] 2MEHAT S chr XD 7 AR
— " RX=T g DA T ) T INEET AARTTCIER LET,

[Visual Library File (lib) ] :
e [Library of effects] @R L EF, ZDT7 7 A /LiE, FAiIC [FXGenerator] 77U 7 —3 3  TIER ST
b0, Fi2iE, BEfFD [Demo Files] ZfH L £,

[Visual Position File (.pos)| :
e  [Sitepositions] Z#E IR L EF, ZD7 7 A /LiE, FHiZ 3D Position Editor] 7 7'V 7r— a U TER I LW

BHH00, F£721%, BEFED Demo Files] Z#f#H L £,

EE: o077 1DO—2THLRIFTTWBES., [Viewer] IZEENTES, RELTWSLT7 7 A LIZONTDH
MENEREINET,
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['Visual Script File] % B <
1. l'Visual Show Director] . [FILE] # 7 > [Visual Script File] Z3#R L C, Vv Y =7 MIA v KR—FLET,

@ Wiy Thaw Decton - |[NSFuitThow)

o B
o Srer Pt
’-‘O Sren Praject As

2 Close Pyt

‘ Progect Liteaey Colel
Sergnt File L3
Scopn Fives Fie 4
Sergt Soct File »
e Fie ’
Ettact Fotar Fie ]

Effect Sort Fie ’

Viruwl Sonpk Fie

BE) veuwpoinic Fe
Wauw Litrary Fie

B
& v

Egt

DASHOWTRECTO R PROEC TN P et Frrtihowayt

2. TMONTREAL.chr] Z&ERT D0, FILWAFIEZMHTTC7 7 A VE2&, Yuav=7 MIBINT 2,

%) Define Visual Script File X
" » Alberta » Dropbox » MOMNTREALZNT v O Search MOMNTREALZOTT »
Organize Mew folder B
J! husic 2 Marme Date modified Type
=] Pictures & backups 12/2/2016 155 P File folder
& videos & | EFFECTS 12/2/2016 .56 PM File folder
i 05 Install (T & LeftFrames TAS20E 240 PR File folder
= Data (D) w  ModelLlaRonde 207207 239 PM File folder
&  Right Frames 7152016 240 PR File folder
ﬂ Metwark SE .
= ] QUEMCES FA5/206 1111 AR File folder
g ALBERTO-MSI

3 ALBERTO-PCT
= INFINITY-2IRPOR.

v £ >
File name: | (OISR 0T o
Save as type: | Visual Script Files (*.chr) ~

» Hide Folders Cancel
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[Visual Library File| % BH<

3RIT, valb—varRkod s [Visual Library| ##RL £,

[File] > [Visual Library File] > D:\SHOWDIRECTOR\PRODUCTS\VISUAL EFFECTS\VISUAL LIBRARIES | (Zf%
£ Cv% TALLEFFECTS022017.lib) #2V v 27 LE7,

3 | VISUAL LIBRARIES & o

»
I o e e °
5 e T LeielI &
< ! .
) v

- 1 hiePC » Data (00 » SHOWDIRECTOR » PRODUCTE » VISMAL EFFECTS » "VISUAL LIBRARIES

L2 Dropba Noens
AlL EFFECTSFX
PATTERNS
3 This PC @ ALLEFFECTS02201 7 0ib
B Deshtop
= Dotuments
& Doanloads
) Muuc
& Pictures
B videos
03 _Fuaal (C:

| - Dats D) v

@& OreDrive

[Visual Position File | :

Wz, A+ EfrERE#A S A7 [Visual Position File| &1k L £,

http://www.infinityvisions.net/software/vsd8-tutorials/
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[3D Position Editor] TH%A kZ/ERT 5

Site DYERK

e ZMNT, [3Dmodel] ZfM LT, %A bOIER L FENEDOBEREM TN E Uiz, AHREM TR ~RZ L 51
CBEBRLIEY A FOBEBE jpg 74—~y P THR ¥ I F ¥ T 5IC1E. [Google Earth] O L 5 ZefigEigy 7 b
=77/, F£721E, . [Sketchup 3D Warehouse| TAFL7=ETLVZEHALET, HHWIL, BEFOEAT A b
D77 ANPEBRRT 5L HETEET,

o ZOHITIEL, [Montreal] fEAREZDOTET Y =2 F YA M LET, 4ENEL. [3dsmodel | N— 3
YEBEALET,

e [3Dmodel) LEILT7ANHFIZTBY =Y NEAERLET,

3D Position Editor] ZB<: A4 A—URIZH LV (Site Folder] Z{ERKT 3,
. [Visual Show Director] T, Y —/\ X—®MO > 3 — v b235 [3DPositionEditor] 77 VU 7 —3 3 & HBERH &
7,

e [3DPosition Editor] 7 A 2 %27 U v 745 L fE7 vt A% T A N4 % [Project Wizard] 28R SIVE T,
[Create New Project] IZF = > 7 Z AL, [0K] %2 Vv 7 LET,
WsdPos3D Project Wizard @@@lﬂ

YWelcome to the VSD 3DPosEditor Project Wizard!

Select the proper operation:

(O lmport aYSD2.0 Project

Show wizard At Startup Ok Cancel

o RDUALVERUNRBE, Loyl hOFERBMLEIZRY I, LRIOBLATILT, DT 4 —/ K& A
*v 7 Cc&xFEd, [Create] 27V v 7 LET,
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=30
Project Mame MONTREAL
Author FvRO
Dezcription COMPETITION SHOW
Pazsword
Create Cancel

e  [FileExplorer] 23B&, 74 L7 MUDBERSNL, Y2y =2 b (pos) 77 ANEREzxbNET, |
LARONDE.pos] &4 ffi+%9. <213 [D:\SHOWDIRECTOR\SITES\ModelLaRonde\LARONDE.pos] T,

-3
- * T™EFC » Data i)+ DHWTIRICTON AT+ Modifonds + Lafondad02 £
tie, e
# Cud
3 Dewhe
& Oraloy
B Thpe
W et
Dw
& e
| RECE
- any )
e
4 o]
Sove v typw Vet Shows Duector K1 Pagiies Fied | POG
e F | e Conid

o KDYy RUT, LBERYA ATV a  OFEORRIENF RENET, T2 TlE, EHED [Create a new
site] ZIBIRL C[OK]|Z 2 VU v 7 LET,
VogFoIID Proyect W g - B |
Welcoms 10 1he VSD 3DPosEdor Progct YWizardl

APl G O s & Wi s W 30 o wed 20 307
8 Donsie nrew G
Crnstn & vhe soeh prowrg pets ! tore poations

T30k 3 e v 8 Dot vkt of OO [R0R A

) Show Wasdde Lung o, Caras

o UTOUAV RUBERESNET, ZITIH, 7RV =2 hOT7 7 AV EHEEZRIRLET, A4 P BB
ONEL 7Y v RORZ 2T YA X ANT 2 Z LPFEFICEEL 20 3, ZOPEZO N TR, ®RICET L
DHTIERMICELET D Z LN TEET,

e YA R4 [LAKE]

o A MEF/LOER : [D:\SHOWDIRECTOR\SITES\ModelLaRonde\LaRonde3DS| /XA CiER L F7,
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o AN A DR [D:\SHOWDIRECTOR\SITES\Hemispherical Textures\Hemis0002.jpg| /XA C#&ERN L E7, (77
ANE AT, jpeg THFHR)
o AT—UHAXF1200m, 7V v KOAZ T H4 T 100m T, %I, K0 EMICHELET,

-] 2,
Site Mame LaKE
Stage Filename D:ASHOWDIRECTORMSITES WModellaR on Browse. .
[ Use Picture as the Graund Field

Sky Filename: DASHOWDIRECT ORASITESYHemispherc Browse...
Terrain Filzhame: Browse...
Terrain Tile width:
Terrain Tile Depth:
Stage Size meters 1200
Square Size meters 100

Apply Cancel

o U4 FUBRFREINT, LETHIITETIEATRETT N, TOLENRTNIT [Yes] 27 U v 7 LET,

Wisual Show Director 30 Position Editor Systern Message

Do you want to wiew the created site?

® Vot (- ot T . s L, - »
' FALZ] o i3 mev [ - e S0 S 7T a2 P
&-%'.a@ o e LA RO ORNS QAN JIFTT A PR TBs AL N EAY
Foe Ve BN T™ »m P et PR ——
1 T -
e WGt | Yt STt W
v - TR AT e Seemer—
i SO ety
.- T A -
- Tohmn AN A W (e
on L L e L ey
- i -
- T inare b =
- T GO A W e
= VAN AN e -
e Wmn A A
Ly DA AR S e -
B8 T Rk A -
s RN LN A | e -
e i s omand
Tnmme Vi | mee - e
T4 meey 2arvar mom =
e b s ™
e I T .

e Lot
MITAE LI B e =
v et =
LR Rl
WETE L .
TR e e -
TG i -
4 -

L S ban

o EbPa—R— IRXRFUZETNEYA FBERENET, [Top, Front, Left Views] 1E [Sky] (Zd& > TREATWE
T, [ShowSky] 7A ar %27 Uy 7 LT, ZNHEFRLTLIEIN,
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8 Quick Start VisualShowDirector

o [Camera) Y —/VZMEH L CHEHGNOREAZE))NL TH T ZEV,  [Top View] DOHTlE [Rotate] Z ] L
BRNWEDICTEELEEW, A LEGAIE. RS20 T TE2 Y v 27 >[Reset] # o T17oTLEE W

3y
e [Move] Y —/b IFT T, Ba—%2HRZBEIL7ZY . [Zoom] Y —/LVEIX T ARA — L EMHLTA—
LAV LET, TEDRVIFEDISLIICA—LA U EZRLTIES N,

. if\x?%V@Eﬁ@WE%LT<ﬁéWOBa&@ﬁmﬂy%wxﬂé:%Eﬂbiﬁoﬁmﬁml
Options] @ [Measure to Set] ##iZ 157 m # AJJ L £,
ZHUTEEROETH Y . ATV EEEORFITRELET, A7 Vv 7] TR halERs L, JE
LTWHIAOfpilcy TEZ7 Uy 27 LET, BT 5ITIE. [Get Measure] Y —/LAfEH L THHIE L £
T, eVl MERGFLTINDOOWEEEHEL ET,

PA MR a V2 REBET S

o ZIZTiX, BHENZ LD Ramp3] (215 AV v a vy ZhdE L ET,
B2 G AT 2 TR T HFEEZ [Top View) DT [Zoom] L £,

FoaPvay U L LN HROORNS QNLGH IFYT 0 5 TDAH AV AN EHT

2 x  ToolOphors .

o Ta—Lhkhv bk Y—— D [Make Position Line] 7 U v 745 &, Hllo<x/11Z, [Tool Options] DX
ENERINET, WOT—FEATTLTIZEN,
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R a VORI EBEEFTT: BRETIRSa oz A LEd, 22Tk, [R301—R315] &9 15
B4 uia £ Lz,
Yool Optoes o HETEBTFOMIILT # LT EAN L, QR VY a VERICHBERIZT O/NE ANE T,

Jpt MseRmbets 4 [R3401) . R3 1 Ramp3 (R3) DT 3 L OAHIT, 01 ZEAIOME. 15 1%

Guneral Prepertes
. [EASeh
=12
Type of Croston
. A7 avd[LassoTool] IZF =752 AT, BT LHRTa v BEASILET,
+ Lassn
Count: 15 [Count]: 15

Massured -
Vecton Cieaton 1 TR L e R a3, [Panand Tilt] : [Pan] =EE, [Tilt] =KFE

P-muu

[Custom] ICF = v 7 Z ANET, THHLDOMETIL, 0-89 EEOAENLAEZFE L, 90 i
Pan: g
Tie @ l 91 E—180 HIFL AL E9, ROKEZAL LTI ZSW,
‘y Pan =270, Tilt=90

e A7 = UiHE TEdit A == — > Preferences > Change % 7 > Tools Colors % iR | :
av R %'ﬁ&%% IFRRTHEDIZ, V= NLDOBEERTEET,

e [LassoTool] THEEDKRY Y a v ZEE: [TopView] OHF T, FAIOMEZRD T AEZLEI Y v 7 Lizh

SR TR U ATREREES, [wURDEI Vv 7] I8, BEOKRA L FTIA L DY—r R

ERETEET, EORA L NEROES T2y 7)) (I T EZYy 2] LET, AP a SR
FolFRSNET,

TopView 5 X Peipociive Vs

o Y —/LOfEERIZ, [ESC] (Escape) @7 U v 7 TWOTHAFETT, MEZIRY ., TOMENEZAV RSN
TWHIREE) 581, [Delete]¥—ZH LT, (iEAZBANL TEELZEEITLET, [Positions Grid) | F
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721% TSelection Tool] THRIY Yz Z@ERNT 5 L3 TE £, [File] > [SAVE PROJECT] 2 ER L TAH Y =
VERIFLET,

e [SimpleLines] Y —/V T, R¥ ¥ a DEEE: RPV 3 2 A00—A09 Z/KFIZEMLET,
[Make Positions Line] > [Simple Lines] ( [Tool Option] H) %R L T, [Count] #iZ 10 ZAJLET, 10
DR Y a r 2fFlT 2I12E, KBEOZ o2 ufiET10mE (E27 Y vy 2] LT, KEORYaT, T
KV ZLTC HEZVy ) LET, 27Uy 7 LENERESNET,

TopView 9 X PespechweVew 7 X ASO0

n

§301, 302 RI0Y Pa0e RI0S RI0E RICT Ha0R RI08 AT

TopView 2 x

HEEQ'”C’ R303 R3I04 R30S R30S RI07 ﬁ)Jﬂ%’.SJB R3WC ‘!3“ BRI R313 RIM BRI
- 4o bt | ‘ - . : P g . o i e A
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1ODRTV Y a r DHDEE:
TiX, IRV v arz =2 RELES, Ya— b Iy b= U v 27 LT, Y—b"—=»b [Single
Position] ([+\]7 A =22) &R L £J, FA{AIIC [Optional Tools] 7 4 & RUNRKRINET,

W VIIUN] WO URSCTO - JU FOIROR SIVIDE © UNSHUWIHEL TLB W I 2 VA 0T R I0M0E L AHON 08 SUTALSHLTIUE 01 « TLMEE ] %E@J\ﬁ :
e Ide Stey Toob lwyout Window Tosibas Melp oY ~
s e = - T, RAVvarsE ) ELET,
BoOahdl Bl w22 HHLELOOHMS -
r-un\f-w 4% LohiVew — "_0:_‘_. T ool Opsons fCJ ka/‘f‘/ﬂ “/@ [Pan] & [Tllt] O)ﬁ};ﬂj
RARRANAL LR AsE-r—: »
S o RSN L ASLET
l.'uhnl—
¢ . [TopView] 7 4 ¥ RUNTv DA
Yeotors Cioatan ° N
" Privgon ettt B IHEI Yy 5L TC) AA U BRR
" Eustes
Fan P @a%éﬂi'ﬂ}
e » I

BT, rv el FEEHINICRTEL
TL 7 &\, [File] > [Save Project]

2£#1%. TREAD 3D Position Editor User
Guide | 2R LT &V,

2 A3 ke loos o
A et b e by

[POSITIONS | DELENET L, ¥ a—DA7 V7 FOW¥FENTE E L7,
[Show Director] (ZF Y [File] A ==—Mm5H, 2O A L% [Visual Position File] & L C®RIRL 7, BIRD/ AL
. D:\SHOWDIRECTOR\SITES\ModelLaRonde\LARONDE.pos] T3,

[File] A == —7>5 [Project Library] Z1&IRT 5L, LLTORRD LI ITHRICPIEE L2 7 A4 W4 LEBIL TV E
R

@

Project Files Path Name Copy
Seript D:5SHOWDIRECTORNPROJECTSMMONTREALZOTMALL POSITIONS WIEW scx
Script Fiter D:%SHOWDIRECTORNSORTS FILTERSASCRIFT SORT sk
Script Sort DeASHOWDIRECTORYSORTS FILTERSYWMASTER SORTS SCRIPT. s5r
Effects D:ASHOWDIRECTORMPRODUCTSAEFFECTS MANAGERSANSUPERLIBRARY. efx
Effect Filter D:ASHOWDIRECTORYSORTS FILTERSAYSUPERLIBRARY. afr
Effect Sort D:ASHOWDIRECTORMNSORTS FILTERSAEFFECTSSORT 2w
WAl DASHOWDIRECTORNMMUSICASOUND TRACK wav
Wigual Script C:h U sershdlberto\DropboxiMOMTREALZ0T P MMOMTREAL. chr
Yigual Pozitions DASHOWDIRECTORMSITESYModellaRondet LAROMDE . pos Wiew Files
Wisual Library D:ASHOWDIRECTORYPRODUCT SWISUAL EFFECTSWWISUAL LIBRARIESAALLEFFECTS022017 b

Browsze Projects Impart Praoject ‘wiite File List ‘ Producer | Cloze ‘

<1 X1 X X1 X X1 X X1 X1 X
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[Viewer] T [Project] %R

ST, AETOTRrY =y FORBEMRLEY, 70V=/ FOETVEFRT I, [V] (Viewer) 71 =
ZEBLET ( Viewer] 7Y RURBEICHED» 02 5HA8H Y T, )

33

BET S &3 ICHERBSNET, F1h, —FHEL, BIRLR LT, ThEUET 27 A 2 2 H
LET,

[Viewer] 7 1 ¥ N DFHE .

774 T, ®NS Viewer] ZB< &, 74—V RORHE & LANVRERENDSO T, Wi B2l ER
ENTHWRVWDPDOEIICAZES, Z7Lb—2NIY Y RZRA > ML, BURAEZRSOTLETEZ Y v %
LTV AZEN LR 2—2B# S ET, vUARA =L T, A=A LET, ARETHIIEZ. LT
DEICH AT Ea—ZEELET,

T4V RUTHO"Y—NV"TALavz7 )y 27 LT, [Viewer] 7L a U RRXNVERES TV a VERENE L
i@ L £ 7, [Display Positions] |25 = v 7 % AiLTC [Applyl %7 U v 7 LT,

B LR Y a AREDO AR RSN ET,
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ol B s

MNartes Of Patchas 0 Wirdhom Lips [IN0.L1)

[Viewer| DH A Z 7 7 )V User Guide

o Ul T AmEEIELIIHEETAI-CCR U a— 2T 570I121X,  [Viewer ] 4> FUIZw T AD
RA v bEBEWEZEE, [CQF—%2MLEJ, [ScriptManager] (Z1T&., F = —DKEHIDFT T [CAMERA] 5D
VM ATOT TN (FTN7 V) AL, 27V 27 LT [Paste] Zi#IRL £,

33Ser ERE ‘
CUE_[HH MM SS FF| MS NEXT | PFT [ DUR | Event Descrip CAMERA | CONTROL [ADDR [MODU| PIN [CGHZ| POS [ PAN [ TILT

7 0/00 00 00 02 067 00:14:27| 0000 | 00:00 |<Capture> ; 000 o o0 oo f
100 00 14 29 14967| 00:04:05] 0000 | 03:07 |<Capture> 000 0 0 00 [a00 [ 0] 90
2/00 00 19 0¢ 19133 00:04:02| 0000 | 03:07 |<Capture> 000 0 0 o0 |AO1 30, 90
300 00 23 06 23200] 00:03:25) 0000 | 03:07 |<Capture> 000 o o o0 [a02 : 0 90
4/00 00 27 01| 27033 00:03:28) 0000 | 03:07 |<Capture> 000 0 0] 00 [a03 ; a0 90
500 00 30 29 30967| 00:04:02] 0000 | 03:07 |<Capture> 000 0 0 00 |a04 a0 90
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